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Резюме: Целта на разработката е да представи основни техники за цифрова интеграция, които 

се прилагат в телевизионната и филмовата индустрия за създаване на краен продукт, който да 

отговаря на съвременните критерии за качество. Акцентира се върху приложни методи за 

създаване на видео съдържание с различно предназначение, както и върху основните 

компоненти на технологичното оборудване на професионално телевизионно студио. Научно-

приложният принос се изразява в сравнителен анализ на софтуерни продукти за видео 

обработка (Adobe Premiere Pro и Openshot Video Editor), който е подкрепен с алгоритми от 

стъпки за изпълнение на основни техники за интеграция в цифровото видео производство. 

Направените изводи относно характеристиките, възможностите и предимствата на избраните 

продукти имат за цел да подпомогнат обучаемите в процеса на усвояването им и тяхното 

ефективно използване за реализация на творчески проекти. 

Ключови думи: видео производство, продуктово видео, видеография, компютърна графика, 

стереопсис, ChromaKey, зелен екран 

Abstract: The aim of this paper is to present basic digital integration techniques that are applied in the 

television and film industry to create a final product that meets modern quality criteria. Emphasis is 

placed on applied methods of creating video content for various purposes, as well as on the main 

components of the technological equipment of a professional television studio. The scientific-applied 

contribution is expressed in a comparative analysis of software products for video processing (Adobe 

Premiere Pro and Openshot Video Editor), which is supported by step-by-step algorithms for the 

implementation of basic integration techniques in digital video production. The conclusions made 

regarding the characteristics, possibilities and advantages of the selected products are intended to 

support the interns in the process of their assimilation and effective use for the realization of creative 

projects. 

Keywords: video production, product video, videography, computer graphics, stereopsis, ChromaKey, 

green screen 

  

1. ВЪВЕДЕНИЕ 

 

По своята същност видеографията представлява технологичен процес на заснемане 

на видео или движещи се изображения с използване на технически средства, като в 

същото време съчетава креативни концепции, онагледени чрез изразните средства на 

видео-изкуството. От своя страна видео-изкуството се формира като нов дял в сферата на 

изкуството през 20 век с появата и развитието на видеотехниката, когато Нам Джун Пайк, 

реализира първите си филми с видеокамера (1960-те години). Необходимо е да се прави 

разграничение между видеографията и кинематографията, тъй като видеографията не е 

свързана със създаване на видео за целите на киното, което може да бъде определено като 

филмово съдържание [1]. 

Проучванията показват, че представянето на продукти чрез използване на видео 

съдържание е предпочитано от потребителите поради използването на мултимедия за 

постигане на цялостно възприятие чрез графична визуализация, аудио, текст и 
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интерактивност. Методи за създаване на видео могат да се обединят в няколко групи в 

зависимост от средствата за реализация - чрез рендериране на анимация в специализиран 

софтуер; чрез заснемане с помощта на видео камера в специализирани студиа или в 

естествена среда и последваща софтуерна видео обработка; чрез използване на различни 

софтуерни продукти за създаване на видео (стереоскопично и холографско). 

Изграждането на реалистичен 3D дизайн за виртуални среди е един от етапите в 

процеса на създаване на продуктово видео в съвременните условия. Богатият 

инструментариум на професионалните продукти за 3D моделиране на реални обекти и 

тяхното анимиране дава възможност за изграждане на виртуална реалност с високо ниво 

на реализъм при визуализация на сцени от физическата реалност, в които хармонично се 

преплитат 3D компютърна графика, анимация и видео. Би могло да се каже, че 

виртуалната реалност е една от основните сфери на приложение на интерактивната 

мултимедия, която дава възможност на потребителя да управлява информационните 

потоци със своите решения. 

В Раздел 2 на разработката са разгледани процеси на създаване на видео съдържание. 

Възможностите за технологично оборудване на телевизионно и радио-телевизионно 

студио са представени в Раздел 3. Технологията зелен екран ChromaKey e обяснена в 

Раздел 4, където е направен сравнителен анализ на два софтуерни продукта за 

практическата й реализация. 

 

2. ПРОЦЕСИ НА СЪЗДАВАНЕ НА ВИДЕО СЪДЪРЖАНИЕ  
 

Схемата на Фигура 1 онагледяват цялостния процес на създаване на видео продукция 

като последователност от отделни етапи и технологичните процеси, които се извършват 

на всеки от тях.  

Фиг. 1. Основни етапи и технологични процеси при създаване на видео продукция 

 

Завършен, монтиран и одобрен видеопродукт се получава на последния етап. Той 

може да включва: 

 корпоративно видео; 

 продуктово видео; 

 анимирано видео; 

 филм. 

Техническа подготовка 

Снимачен процес 

Монтажен процес 

Процес на озвучаване 

Еталониране / мастеринг 
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Компонентите на мултимедийния видео файл са изброени, както следва: 

 контейнер (AVI и Quicktime MOV, MPEG) - файл за идентифициране на 

различни видове данни: видео и аудио потоци; субтитри; информация за данни и 

метаданни (тагове); информация за синхронизация с цел всичко да работи едновременно. 

 кодек – софтуер за кодиране и декодиране на видео сигнал или още метод за 

кодиране и декодиране на видео и аудио сигнал в контейнера. Например „протоколът 

H.323 дефинира гласови кодеци“, докато „видео кодеците са  H.261 и H.263” и се 

използват за „компресиране и декомпресиране на медийни потоци“ [2]. 

 видео и аудио сигнал – характеристиките на видео сигналите са представени 

в Таблица 1.  

Таблица 1. Характеристики на видео сигналите 

СТАНДАРТ РАЗДЕЛИТЕЛНА СПОСОБНОСТ 

PPAALL  ((Phase Alternating Line – „поредова 

смяна на фазата“)  

SSEECCAAMM  ((Séquentiel couleur à mémoire; 

SEquential Couleur Avec Memoire,  

Sequential Color with Memory) означава 

последователен цвят с памет 

На аналогов сигнал: 720 × 576 

пиксела за Европейския стандарт на 

разлагане 625/50 с честота на кадрите 

от 50 Hz (2 × 25). 

NNTTSSCC  ((National Television System 

Committee) 

На аналогов сигнал: 720 × 480 

пиксела при Американски стандарт 

на разширяване 525 / 60 с честота – 

59,94 Hz (2 × 29,97). 

HHDDTTVV  ((High Definition Television) 

За цифров сигнал: 1920 × 1080 

пиксела при честота от 50 Hz (60 Hz 

за САЩ). 

33DD  TTVV   
Пример за резолюция на 3D видео е 

512 × 512 × 512 пиксела. 

В телевизионните системи форматът на дисплея е основна характеристика на видео 

сигналите. В съвременните кинематографични системи съотношението на страните на 

екрана е 1,85:1, а в телевизионните - 16:9 (1,78:1). Друга тяхна характеристика е скоростта, 

като е известно, че минималната скорост, с която човек възприема изображението гладко, 

е 16 кадъра в секунда, но в действителност това число е индивидуално за всеки човек. В 

съвременната кинематография тази скорост е 24 fps, а в телевизията - 25 fps (PAL/ SECAM) 

и 30 fps (NTSC). 

Различават се два вида управление на ширината на потока във видеокодеците: 

постоянен битрейт (англ. constant bit rate, CBR); променлив битрейт (англ. variable bit 

rate, VBR) - концепцията на VBR е да съхрани максимално качеството на видеото, докато 

намалява сумарно обемът на предавания видео поток в момента. „При сцени с много и 

бързи движения на картината ширината на видео потока расте, а на забавените сцени, 

където картината се променя бавно, намалява“. 

Честотата на видео сигналите e броят на неподвижните изображения, които се 

появяват едно след друго в рамките на една секунда, за да създадат движение на обектите 

на екрана. Горната гранична честота на трептенията, възприемана от човешкия мозък, е 

индивидуална за всеки, зависи от условията на наблюдение и има средна стойност 39 – 42 

Hz. Съществуват свръхскоростни камери, при които фотографският филм е неподвижно 
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закрепен по вътрешната повърхност на барабан, а изображенията се получават от въртяща 

се призма. „Честота на снимане на професионалните камери е 120 Hz, на 

специализираните – 1000 Hz, а на свръхскоростните – няколко милиона кадъра в 

секунда“. 

„При някои типове видео се използва масив от информация вместо кадри за 

изменението във времето на сигнала от всеки датчик (пиксел). Светлочувствителен 

сензор предава с висока честота своето моментно състояние, което се записва на 

носител. При възпроизвеждането също няма кадри – на екрана пикселите менят своя 

цвят в съответствие със записаните данни. За визуализация на видеото е необходим 

специален монитор“ [3]. 

Алгоритмизацията на процеса на видео производство е представена на Фигура 2. 

Фиг. 2. Алгоритмизация на процеса на видео производство 
 

На Фигура 3 е показана примерна класификация на типовете видео съдържание, което 

може да бъде достъпно в интернет пространството.  

Фиг. 3. Примерна класификация на типовете видео съдържание в Интернет 



Годишник Телекомуникации 2023, том 10, с. 01-13 

Yearbook Telecommunications 2023, vol. 10, p. 01-13 

eISSN 2534-854X                                               https://telecommunications.nbu.bg/bg/godishnik-telekomunikacii 

DOI: https://doi.org/10.33919/YTelecomm.23.10.1 

 

5 

 

Независимо към кой от изброените типове се отнася дадено продуктово видео, 

непосредствено преди неговото възпроизвеждане, то може да бъде конвертирано в 

стереоскопично, ако предварително не е заснето като такова с помощта на 

специализирани средства (стереоскопични камери). На Фигура 4 е показан алгоритъм за 

създаване на видео, което впоследствие да бъде конвертирано в стереоскопично и 

възпроизведено на екран чрез специализирани технически средства за визуализация. 

Фиг. 4. Алгоритъм за създаване и визуализация на стереоскопично видео 

 

В съвременните 3D системи за визуализация стереопсисът (стереоскопия) и 

автостереоскопията се използват за постигане на ефект на дълбочина в сцените чрез 

възпроизвеждане на бинокулярното зрение (binocular vision от лат. bini – double, oculus – 

eye), т.е. свойството на човешкия мозък да съпоставя изображенията от лявото и дясното 

око, които виждат под различен ъгъл. Зрителните оси се пресичат в точката на 

разглеждания предмет. За разлика от стереопсиса, който се реализира чрез специални LCD 

(Liquid Crystal Display) екрани и очила, автостереоскопията се реализира чрез иновативни 

холографски техники, които дават възможност за визуализация на множество изгледи. 

 

3. ТЕХНОЛОГИЧНО ОБОРУДВАНЕ НА ПРОФЕСИОНАЛНИ СТУДИА 

 

Специализираните снимачни студиа за занесмане на видео или филмова продукция 

се класифицират, както следва: 

 телевизионно студио - специализирано инсталационно помещение, в което се 

реализира снимачен процес или се излъчва телевизия на живо. След запис на 

видеокасета или SSD (Solid State Drive) необработените кадри се използват на 

етапа „ постпродукция“. В радио-телевизионните студиа се реализира и 

радиоизлъчване. 

 филмово студио - специализирано помещение, което е собственост на 

развлекателна или филмова компания. В него се инсталират съоръжения за 

заснемане на филмови продукции. 
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Изграждането на телевизионно студио се извършва на следните етапи [4]: 

 проектиране – в Таблица 2 е систематизирано ресурсното осигуряване на 

телевизионно студио, като устройствата и оборудаването на контролната зала и мрежа са 

представени в отделна колона; 

 автоматизация; 

 излъчване – съществуват различни критерии за класификация на видовете 

телевизия, сред които са: статут (обществена и частна), начин на разпространение (Фигура 

5), тип на излъчвания сигнал (аналогова и цифрова), разделителна способност (със 

стандартна резолюция и HDTV), обхват на телевизионното разпръскване (национална, 

локална, регионална), тематиката на предаванията (политематични и специализирани) и 

др. [5, 6].  

Таблица 2. Проектиране на телевизионно студио 

 ОСНОВНИ КОМПОНЕНТИ КОНТРОЛНА ЗАЛА И МРЕЖА 

У
с

т
р

о
й

с
т

в
а

  Пач панели и кабели: 

 традиционни кабели (Co-

Ax SDI, K ready 12G-SDI); 

 Ethernet (VoIP). 

 Системи от камери: 

 камкордери; 

 микрофони и аудио. 

 Осветление: 

 LED светлина; прожектор; 

 Видео превключватели; 

 Енкодер / декодер - за получаване 

на отдалечени видео сигнали; 

 Видео стена на контролната зала: 

 монитори, окачени на 

персонализирана скоба, чрез които 

се управляват всички видео и аудио 

компоненти. 

О
б

о
р

у
д

в
а

н
е

 

 Монтаж: 

 осветителни системи – 

(статични и автоматизирани, 

окачено осветление); 

 LED стени; 

 сценични елементи; 

 мебелировка; 

 комуникационни системи; 

 виртуални комплекти. 

 Системи за управление: 

 графични системи за управление на 

ефирни графики, LED стени и др.; 

 система за автоматизация - за 

осигуряване на единен контрол върху 

системните компоненти (осветление, 

аудио и др.); 

 Информационна компютърна 

система; 

 Шумоизолиран мрежов шкаф за 

сървъри. 

 

Техническото оборудване на радио-телевизионно студио трябва да надгражда 

гореизложената концепция със следните основни компоненти: 

 технически оперативен център; 

 студийна система за ефирното студио; 

 звукова част: източник на звукова част; 

 телефони, компютърно оборудване, ефирно оборудеване, системен и приложен 

софтуер, светлинна сигнализация, монтажно оборудване; 

 студийна система за продукционно студио: звукова част, компютърно 

оборудване, монтажно оборудване; 

 телевизионна система: видео част, компютърно оборудване; монтажно 

оборудване; 

 продукционно студио: видео част, светлинна сигнализация, монтажно и 

компютърно оборудване, комутатори LAN; 

 ефирно оборудване – предаватели (FM, интернет предавател), оборудване за 

външни репортажи, монтаж и настройка. 
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Фиг. 5. Kласификация на видовете телевизия 

 

Модерните телевизионни студия разполагат със собствена DVB-T (Digital Video 

Broadcasting-Terrestrial) система за осигуряване на високо качеството на картината и звука. 

Това е стандарт, сертифициран и публикуван от Европейския институт за стандартизация 

в далекосъобщенията, за наземно излъчване на цифрово видео, който позволява 

едновременното излъчване на пакет (мултиплекс) от 8 MPEG-4 телевизионни програми на 

един канал [7, 8]. Съществуват специализирани „бази данни за сравнение на спектър и 

честотен план“, които предоставят полезна информация относно радиозапис на наземни 

радио услуги (TERRASYS), DTV (Digital TV) международно цифрово телевизионно 

излъчване (RRC-06) и др. [9]. 

DVB е базиран е на MPEG-2 транспортен поток, в който данните се предават в 

пакети с фиксиран размер (188 байта). В практиката се прилага метод за включване на IP 

над MPEG-2/ DVB поток чрез капсулиране, при който IP-фрагментите са директно 

пакетирани в полезен товар. Най-разпространеният IP над DVB протокол за капсулиране е 

MPE – Multi-Protocol Encapsulation, чрез който един IP пакет се капсулира в отделна 

MPEG-2 част независимо от размера си. Протоколът за поточно предаване на данни за 

капсулиране използва „PES“ (Program Elementary Stream) капсулиране на IP пакети или 

фрагменти [10]. 

Инсталацията на комуникационни системи за цифрови медии изисква софтуерни и 

хардуерни инструменти за: 

 кодиране;  
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 аудио; 

 смесване на видео източници и добавяне на специални ефекти към тях -  използват 

се устройства, които се наричат видеомикшери (Vision Mixer). Те могат да правят 

избор между няколко видео източника. 

 безлентови работни процеси (Tapeless Workflow); 

 интеграция; 

 съхранение; 

 мобилни производствени решения; 

 технически, интеграционни и отдалечени услуги. 

 

4. СРАВНИТЕЛЕН АНАЛИЗ НА СОФТУЕРНИ ПРОДУКТИ ЗА ВИДЕО 

ОБРАБОТКА 

 

Избраните от автора продукти за практическата част на разработката са 

професионалният софтуер за видео обработка Adobe Premiere Pro и софтуерът с отворен 

код Openshot Video Editor. Обосновката на избора им е, че и двата продукта разполагат с 

възможности за реализация на технологията зелен екран ChromaKey, добавяне на ефекти и 

субтитри към видеото, импортиране на 3D обекти в него и др. Технологията ChromaKey се 

прилага широко в киното и телевизията, тъй като дава възможност предварително заснето 

на зелен или син екран движещи се обекти да бъдат изрязани софтуерно от зеления фон и 

вградени във видео среда. Когато трябва да бъде заснета човешка фигура, която 

впоследствие да се изреже от фона и да се импортира във видеото, се изисква фонът зад 

нея да е в цвят, който не присъства в човешкото тяло, за да няма риск от нарушаване на 

нейната цялост. Такива цветове са зеленият и синият.  

Съществуват различни софтуерни продукти с отворен код, с които обект, заснет на 

зелен екран, може да бъде изрязан от зелен фон. Освен избраните за сравнителния анализ 

софтуерни продукти, авторът е запознат с LightWorks, Open Broadcast, VSDC Free Vodeo 

Editor, VirtualDub и Wax. Но от изброените продукри с отворен код, Openshot Video Editor 

е избран поради две основни предимства: 

 предоставя указания за работа на български език, което го прави подходящ за 

обучаеми в програми на български език; 

 отличен е с „награда за апликация с отворен код“. 

След добавяне на видеото на зелен екран, прилагането на ефект Chroma Key от 

Ефекти (Effects) става чрез плъзгането му върху видеоклипа в Писта 1 (Track 1), като 

индикация за успешното добавяне на ефекта е иконката, която се появява преди името на 

файла. Тя съвпада с първата буква от наименованието на самия ефект (в случая „C“). 

Настройките на ефекта се визуализират, когато се кликне върху иконката C с десен бутон 

на мишката. От менюто се избира Properties и настройките се появяват в отделен прозорец 

вляво (Фигура 6). 
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Фиг. 6. Достъпване на настройките на ефект ChromaKey в Openshot Video Editor 

 

Следва да се направи избор на цвят от екрана с двоен клик на ляв бутон върху Key 

Color > Pick Screen Color > клик върху фона на видеото > ОК (Фигура 7). Ако след тази 

стъпка около заснетия обект се забелязва зелен контур, е необходимо е да се отиде в 

самото начало на видеото и да се избере Fuzz: 180. 10. Ако след първото добавяне на 

ефекта, все още се наблюдава зелен контур, Chroma Key се прилага втори път, като този 

път се избира по-тъмен нюанс на зеления цвят и друга стойност на Fuzz между 50 и 100. 

Тази стъпка може да се изпълни толкова пъти, колкото е необходимо до постигане на 

желания краен резултат, който до голяма степен зависи от качеството на видеото и 

индивидуалните умения на обучаемите. 

Фиг. 7. Изрязване на обект от зелен фон в Openshot Video Editor 
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Следва аналогичните стъпки да бъдат изпълнени в Adobe Premiere Pro, който се 

отличава с по-висока сложност в сравнение с Openshot Video Editor. На Фигура 8 се вижда, 

че фоновото анимационно видео и видеото на зелен екран [11] са добавени в първия 

прозорец чрез File > Import и поставени с плъзгане съответно в track V1 и V2, така че да се 

насложат едно над друго. За да има възможност за редактиране на видеото, трябва да се 

кликне два пъти върху него с ляв бутон на мишката. В Source > Effect Controls отново се 

кликва върху видеото, за да станат видими настройките Motion, Rotation и т.н. 

Фиг. 8. Импортиране на мултимедийни файлове в Adobe Premiere Pro 

 

 Позициониране и преоразмеряване на видеото със сателита се прави чрез Position и 

Scale. Следващата стъпка е аналогична на тази в Openshot Video Editor - за да се отстрани 

зеленият фон на видеото, се избира Effects и от панела вдясно – Video Effects > Keying > 

Ultra Key, който трябва с плъзгане да се постави върху видеото със зелен екран. Ultra Key 

се визуализира в левия панел в Editting > Effect Controls. Кликва се на правоъгълничето 

срещу Key Color и с помощта на пипетката се „взема проба“ от зеления фон на самото 

видео чрез кликване (Фигура 9) и се натиска бутона ОК, за да бъде премахнат зеленият 

фон. 
 

Фиг. 9. Изрязване на обект от зелен фон в Adobe Premiere Pro 
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За по-добър резултат може да се променя стойността на Color Tolerance, като в 

случая е 200, но крайният резултат до голяма степен зависи от резолюцията на видеото. 

Видео файлът следва да се запише в подходящ мултимедиен формат от File > Export > 

Media (Фигура 10). 

Фиг. 10. Запис на видео файла във формат AVI. 

 

Важно е да се обърне внимание на настройките в прозореца Export Settings: Video 

Codec задължително трябва да бъде Uncompressed. Резолюцията трябва да бъде минимум 

800 x 600 пиксела, но е препоръчително да бъде същата като на авторското анимационно 

видео (3D сцената, създадена в 3DS Max). 

В заключение може да се направи извод, че създадените визуализации са напълно 

равностойни от гледна точка на качество съобразно конкретната задача, свързана с 

използване на технологията Chroma Key. 

 

5. ЗАКЛЮЧЕНИЕ 

Съвременните техники за интеграция в цифровото видео производство са само един 

от много примери, които могат да бъдат дадени по отношение на технологичната 

еволюция. Поради своите предимства съвременните мултимедийни продукти спомагат за 

повишаване качеството на образование във всички сфери. Интерактивните мултимедийни 

приложения предоставят практически неограничени възможности на потребителите при 

извършване на редица дейности, свързани предимно с обучение. Пример за това са 

компютърно-подпомаганите учения за целите на сигурността, реализирани в 

симулационни тренажори под формата на симулационни игри и ситуационни сценарии, в 

които информационните и комуникационните технологии се прилагат съвместно. 

Тенденциите за развитие са свързани с холографските симулации, които биха 

спомогнали за изучаване на редица процеси, както и с холографските 3D 

видеокомуникации [12], които са надграждане над вече съществуващите канали с 

холографско съдържание, съдържащи холографски видео клипове [13], създадени 

софтуерно с помощта на Adobe Premiere Pro и други аналогични продукти (например 

Camtasia Studio). 
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